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1  Introduction 

 
 

 
 

Figure 1-1  MissionSpan™ NMS User Interface 
 
 
MissionSpan™ NMS (Figure 1-1) is a lightweight network control application for one or 
more constellations of smallsats or airborne commnications systems. It is principally used 
for configuration of our software defined radios (Quest™ and Connect™ satellite 
modems) but is easily adapted for wider system application. Key features and benefits 
include: 
 
 

• Support for up to 10,000 satellites and up to 100 different constellations. 

• Multi-operator application with secure individualised operator login. 

• Centralized database for storing any number of modem configurations. 

• Ability to create and distribute modem configurations across the network and 
upgrade modem software over the air. 

• Centralized monitoring and control of all ground and satellite onboard network 
equipment. MissionSpan™ provides a view of all the TXMission (and potentially 
other) devices in the network. Networks are structured as one or more 
constellations, sites and devices that are displayed in a navigation tree. Clicking 
on any device connects to and displays the user interface for that device, which 
can be used to monitor and control its functions. 

• MissionSpan™ uses password protection and secure network communications to 
ensure security. 

• Integrated test tools such as an OOPS! command line terminal emulator that can 
be used to build up or modify modem configurations held in the local 
MissionSpan™ database or to directly control any modem in the network (OOPS! 
is our open-source protocol for communicating with smallsats and airborne 
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vehicles). 

• Provides continuous background status polling and alarm reporting of all 
equipment. 

• Application runs on standard Windows by default (Linux and macOS installations 
are available on demand). 

• Virtual Network Operator (VNO) operation is supported, giving third parties a 
controlled degree of access to part of the network. 

• Application runs on standard Windows by default (Linux and macOS installations 
are available on demand). 

• Based on open standards that allow easy integration of third-party equipment. 
 
 
In future, MissionSpan™ will support the ability for users to manage their own 
applications running on our modems, including automated uploading of new software 
versions to a targeted subset of the devices in the network. 
 
This manual will guide you through the process of installing and using MissionSpan™ in 
your ground station or test environment. 
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2  Installation 

 
 
MissionSpan™ NMS is a Windows application that runs on Windows computers. 
(Installables for Linux and macOS are available on request.) 
 
The computer should meet the following specification as a minimum: 
 
 

1. Microsoft Windows 10 
2. Intel i5 processor 
3. 8GB memory 
4. 500MB of free disk space 

 
 

 

 
MissionSpan™ is provided as a compressed 7-Zip file (Figure 2-
1). 7-Zip is an archiving tool that can be downloaded freely from the 
internet. WinZip can also be used. Ensure that 7-Zip or a compatible 
archive tool is available before proceeding. 

 
 

 

 
 

Figure 2-1  Installation Zip File 
 

 
The installation process for the application is as follows: 
 

 
1. Navigate to the destination folder where MissionSpan™ is to be installed and 

open the archive (you may need to right-click on the file and select ‘Open’ or 
‘Open archive’). The archive tool will display the contents of the zip file (see 
Figure 2-2). 
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Figure 2-2  Installation Zip File Contents 
 
 

2. Select the Extract button in order to extract all files and choose the destination 
folder as shown in Figure 2-3. 

 
 

 
 

Figure 2-3  Extracting the Installation Zip File Contents 
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3. Following extraction, the contents of the destination folder should now look like 
Figure 2-4. 
 
 

 
 

Figure 2-4  Installation Folder Contents 
 
 

4. Right clicking on the MissionSpan.exe file brings up a context menu as shown in 
Figure 2-5 that allows a desktop shortcut to be created and allows MissionSpan to 
be accessed directly from the Windows Start Menu or Taskbar, if desired. 
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Figure 2-5  Creating Desktop Shortcut to Application 
 
 

5. Multiple instances of MissionSpan can run concurrently on the same or different 
computers. The single-user version of MissionSpan installs a local configuration 
database on the computer. The multi-user version allows the database to be 
located on a shared server drive, ensuring that all changes made to the network 
configuration are propogated to all operators in real time. 
 

6. Double click on the MissionSpan.exe file to start the application. The login 
procedure is described in the next section. Note that a modem simulator is 
provided as a separate installation file and can be used with MissionSpan to 
simulate any number of modems – see Chapter 4 Appendix. 
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3  User Guide 

 

3.1 Starting the Application 

Double click on the MissionSpan.exe file in the installation folder to start the application. 
This will bring up a login screen as shown in Figure 3-1. 

 
 

 
 

Figure 3-1  MissionSpan™ Login Screen 
  
 

The default username and password are admin and txmission, respectively. 
 
 

 

 
It is strongly recommended that to ensure security, the default 
admin password is changed immediately on first logging in. 

 

 
 
The admin user cannot be deleted. Other user login names can be added as required. 
 
When starting the application for the first time, Windows will display a warning as shown 
in Figure 3-2. Uncheck both boxes and select Cancel, as MissionSpan does not need 
any special permissions in relation to Windows Firewall. 
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Figure 3-2  Firewall Warning Screen 
  
 

Following successful login, the screen shown in Figure 3-3 will be displayed. This shows 
an example network held in MissionSpan’s database, which can be deleted (as explained 
later) if it is not required. 
 
 

 
 

Figure 3-3  Main Application Screen 
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3.2 User Interface Layout 

MissionSpan’s user interface comprises several elements as described in the following 
sections. 
 
 

3.2.1 Navigation Tree 

The navigation tree (Figure 3-4) is located on the left-hand side of the screen and is used 
to navigate to sites and devices within the currently selected network. The currently 
selected site or device is indicated by being highlighted.  
 
 

 
 

Figure 3-4  Navigation Tree 
 

 
Networks comprise one or more sites and sites contain one or more devices. Devices 
typically represent TXMission modems but could potentially be any network device that 
supports an embedded web server. Sites are usually physical locations such as ground 
stations, equipment racks, satellites or airborne vehicles where the network devices are 
located. However, a network could be structured in other ways, for example, as sets of 
devices that provide specific network services. 
 
Nodes on the tree can be expanded or collapsed as required by clicking on the node. For 
larger networks, a scroll bar will appear on the right-hand side of the navigation area to 
allow access to network nodes that are not in the visible area. 
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The navigation tree therefore provides a convenient way of accessing and managing all 
devices in the network. 

 
 

3.2.2 Display Area 

The right-hand side of the screen is a display area that provides the functionality 
described in the following sections. 
 
 

3.2.2.1 Local Menus 

The display area is used to display menus that allow the operator to manage local 
network configuration (via MissionSpan’s internal database). This mode of operation is 
referred to as Local mode because it does not directly interact with, or change any 
settings for, any network device. Essentially it operates as an off-line mode where the 
operator defines and maintains settings for networks, sites, devices, users and modem 
configurations. Local mode can be used to create and maintain network information for 
any number of networks (such as satellite constellations or fleets of aircraft). 
 
Local mode menus (Figure 3-5) are displayed in a silver colour scheme and show the 
MissionSpan logo at the top of the display area. The different sections of each menu can 
be collapsed or expanded using the -/+ icon located at the top right of each section 
header title. 
 
 

 
 

Figure 3-5  Local Menu System 
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As can be seen, a fly-out side navigation menu (Figure 3-6) is located on the left-hand 
side of the display area. 
 
 

 
 

Figure 3-6  Local Mode Fly-out Side Navigation Menu 
 
 
The fly-out menu provides options for: 
 
 

• Modem configuration (Home menu) 

• Network configuration 

• Site configuration 
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• Device configuration 

• User configuration 

• Command line interface 

• Local system log display 

• A Help menu (provides access to this manual) 
 
 
The local menus are described in detail in the relevant parts of this manual that deal with 
the above functions. 
 
As mentioned, the database can hold all configurations for all modems. The MissionSpan 
database, in whole or in part, is transferrable to the modems in the network, allowing all 
the configurations to be maintained centrally and then distributed throughout the network 
whenever required. A typical scenario is that each modem will store several alternate 
configurations (comprising transmission frequencies, data rates, waveforms, etc.), 
representing different network services, which can be switched on demand. 

 
 

3.2.2.2 Remote Menus 

Another use of the display area is when the operator clicks on a device in the navigation 
tree, the display area is used to display the device’s built-in web server, as if it were being 
accessed from a browser. This is referred to as Network display mode. At this point, the 
operator can monitor and control the device using a set of web pages and menus 
provided by the device itself, which replace the local menu system. 
 
Remote menus (Figure 3-7) are displayed in an amber colour scheme and display the 
TXMission logo at the top of the display area. Remote menus contain a fly-out side 
navigation menu that partially overlaps MissionSpan’s fly-out menu, but which also has 
features that are unique to the modem web server. However, the commonality of user 
interface features and style between MissionSpan and the modem web server means that 
operators who are familiar with either can easily learn to use the other.  
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Figure 3-7  Remote (Modem) Menu System 
 
 
The modem web server is documented in a separate user manual. However, as 
mentioned, there is a significant degree of overlap in relation to the basic modem 
configuration features available in MissionSpan’s Local mode, which are described later 
in this manual. 

 
 

 

 
To switch back to Local mode, the operator selects Local from the 
application Win menu (described later). 

 

 
 

3.2.2.3 Command Line Interface 

When in Local mode, there is a menu option that provides access to a command line 
terminal emulator (Figure 3-8). The terminal implements TXMission’s OOPS! command 
line protocol. This is another way of managing network devices and of defining modem 
configurations in MissionSpan’s local database. The operator can choose whether to 
send commands to update the local database (to create or edit modem configurations) or 
to any network device (which will action and update its own database when it receives the 
commands). 
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Figure 3-8  Command Line Terminal Emulator 
 

 
The command line interface (CLI) is distinguished by the fact that it can operate in both 
local (Local) and remote (Network) modes, targeting either the local database or a remote 
modem.  

 
 

3.2.3 Application Menus 

The Application Menus are displayed at the top left of the main screen as shown in 
Figure 3-8. As the name suggests, these give access to application-level functions such 
as switching between modes of operation or exiting the application. These menu options 
are described later in the document in the context within which they are normally used. 
 
 

 
 

Figure 3-8  Application Menu System 
 

 

3.3 Defining a New Network 

MissionSpan organizes communications resources into networks, sites and devices. Sites 
represent meaningful parts of the network such as locations, racks of equipment or types 
of service. Devices are typically TXMission modems but can be any network device that 
supports an embedded web server as its user interface. 
 
This section describes how to set up a new network (using the Networks, Sites and 
Devices menus shown in Figure 3-6). 
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An example of sites and modems in a network is shown in Figure 3-9. Sites are depicted 

by the � (factory) icon. Ground station modems are indicated by the � icon and 

onboard modems by the � icon. Other types of devices are shown using the � icon. 

 

 
 

 
 

Figure 3-9  Network Navigation Tree showing Sites and Modems 
 
 

3.3.1 Adding a Network using the Networks Menu 

While in Local mode, select the Networks option from the fly-out menu in the display area. 
This will display the Networks menu shown in Figure 3-10. Note that the title of this 
screen indicates that Constellation 2 is the currently selected network, meaning that 
Constellation 2 will be displayed in the navigation tree. 
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Figure 3-10  Networks Menu 
 
 
To create a new network, just enter a name in the Add section and click the Create 
button. The new network will now appear in the list of networks shown in the Network 
name dropdown box of the Load/Delete section, although at this stage the network has 
no contents. For example, after adding and loading New network, the Networks screen 
should look like Figure 3-11. 
 
 

 
 

Figure 3-11  Networks Screen after adding New Network 
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The new network can be loaded into the navigation tree at any stage by selecting it from 
the list of networks and clicking the Load button. At this point we want to add sites and 
modems to the network as described in the following sections. 
 
 

3.3.2 Adding Sites to a Network using the Sites Menu 

While in Local mode, select the Sites menu from the fly-out menu in the display area. This 
will display the screen shown in Figure 3-12. 
 
 
 

 
 

Figure 3-12  Sites Menu 
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To add a site, enter the new site name in the Add section and, using the dropdown 
control, select the network that the site is to be associated with. (Sites can only be 
associated with one network.)  Then select the Create button. Repeat this process for 
each new site. Note that sites will not appear in a network until they have at least one 
device associated with them. 
 
A site can be deleted if necessary, using the Delete control. 
 
Note that when the new site name is entered into the Add section, the background colour 
for this section will change to red (Figure 3-13). This is a common feature of data entry 
on all screens and acts as a reminder to submit the request using the appropriate button 
(Create or Cancel in this case). 
 

 
 

 
 

Figure 3-13  Red indicates data has changed and form needs to be submitted 
 
 
Following entry of a new site, the Sites screen will now show the additional sites (Figure 
3-14). 

 



MissionSpan NMS User Manual 
 

 3-13 

 
 

Figure 3-14  Sites Screen after adding New Site 
 
 

3.3.3 Adding Devices to a Network using the Devices Menu 

While in Local mode, select the Devices menu from the fly-out menu in the display area. 
This will display the screen shown in Figure 3-15. 
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Figure 3-12  Devices Menu 

 
 
The process for adding modems is as follows: 
 

• Add the new modem name in the Add section. 

• Enter an IP address in dotted decimal notation (e.g. 192.168.0.1).  

• Assign the modem to a site using the Site dropdown box. 
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• Select a username to be used to log when logging into the modem. (The 
password will be provided automatically from MissionSpan’s database.) 

• Select a display icon that represents the type of device. This is used for display 
purposes only to indicate to the operator the device type being accessed. 

• Click the Create button to store the data in the database. 

• Repeat the process for each modem or device. 
 
 
Devices can only be associated with one site. 
 
A device can be deleted if necessary, using the Delete control. 
 

 

3.4 Using and Editing Networks 

 

3.4.1 Loading a Network 

Operators may have to work with several networks at the same time. Only one network is 
currently presented to the operator at any time. Consequently, the operator may need to 
load different networks as circumstances demand. 
 
To do this, while in Local mode, select the Networks option from the fly-out menu in the 
display area. This will display the Networks screen shown in Figure 3-13. Select the 
required network from the dropdown box and select OK from the confirmation dialog, at 
which point the network will be loaded into the naviation tree. 
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Figure 3-13  Networks Screen – loading a network 

 
 

3.4.2 Editing a Network 

Once a network has been created, it may be necessary from time to time to edit the 
existing network structure to reflect changes made to equipment and services. See the 
following sections for instructions on editing sites and devices. 
 
While in Local mode, select the Networks option from the fly-out menu in the display area. 
This will display the Networks menu shown in Figure 3-14. Although a network contains 
sites and devices, the network itself is defined only by its name. The network name 
cannot be edited and therefore the only option available is to delete the network using the 
Delete control shown in Figure 3-14. 
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Figure 3-14  Networks Screen – deleting a network 

 
 
Select OK from the confirmation dialog to delete the network. Deleting a network does not 
delete its sites or devices. Following deletion of a network, its associated sites and 
devices can either be reallocated to other networks, left unassigned or deleted. 
 
 

3.4.3 Editing Sites 

While in Local mode, select the Sites emnu from the fly-out menu in the display area. This 
will display the screen shown in Figure 3-15, which shows a site being moved to be part 
of another network. The name of the site can also be changed. Selecting the Change 
button will cause the changes to be stored in the database. 
 
The Delete control can be used to delete a site. 
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Figure 3-15  Sites Screen – editing a site 
 
 

3.4.4 Editing Devices 

While in Local mode, select the Devices menu from the fly-out menu in the display area. 
This will display the screen shown in Figure 3-16, which shows a device being moved to 
another site. The name of the device can also be changed. Selecting the Change button 
will cause the changes to be stored in the database. 
 
Devices can only be associated with one site. The Delete control can be used to delete a 
device. 
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Figure 3-16  Devices Screen – editing a device 

 
 

3.5 Local Menus 

Local menus are available when MissionSpan is in Local mode (i.e. not displaying the 
user interface from any network device). The local menus are accessible from a fly-out 
side navigation menu (Figure 3-17) located in the right-hand side display area. 
 
MissionSpan’s Networks, Sites and Devices local menus are described in Sections 3.3 
and 3.4, which takes the reader through the process of creating and maintaining 
communications networks. This section describes the remaining local menus (as shown 
in red in Figure 3-17). 
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Figure 3-17  Local Side Navigation Menu 
 
 

3.5.1 Modem Configuration (Home) Menu 

A key function of MissionSpan is giving operators the ability to create modem 
configurations that are ultimately transferred from MissionSpan to the modems 
themselves either pre-deployment or after they become operational. The modems have 
this same capability for creating configurations and can store any number of 
configurations but there are two advantages to managing modem configurations using 
MissionSpan: 
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• To create or edit a configuration using a modem, the modem itself needs to be 
available, online and needs to support a compatible feature set for the 
configuration being created. By contrast, MissionSpan can be used to create and 
modify configurations at any time and does not require any modems to be 
available. 

• MissionSpan can act as a central repository for modem configurations. Creating 
lots of different configurations on the modems themselves is a potentially error 
prone process. By contrast, basic templates can be created in MissionSpan and 
new configurations can then be cloned from these with just a few key parameters 
being changed (such as transmission frequencies) as required. For larger 
constellations this is highly efficient. 

 
Because of its importance, and to create commality with the modem’s web user interface, 
the modem configuration menu is called the Home menu (Figure 3-18). 
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Figure 3-18  Modem Configuration (Home) Screen 
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3.5.1.1 Unit Menu Options 

The Unit menu allows entry of the following: 
 
 

• Modem ID 
 

The Modem ID is a meaningful name allocated to the modem. Its location or the 
service it provides is often used for this purpose. The name format supports the 
space key and all visible keyboard characters. 
 
Note that this is not the same as the name of the configuration under which the 
information is stored in MissionSpan’s database. 
 

• Address 
 

This is the IP address of the modem and is entered in dotted decimal notation 
(e.g. 10.1.0.1). 
 
Onboard modems support a single Ethernet port whereas ground modems 
support two. In the case of onboard modems, link traffic and monitor and control 
use the same address. For ground modems, the address is associated with the 
monitor and control port (referred to as the M&C or TT&C port) and is used when 
the operator wants to access the modem’s web server or command line function. 
The ground modem traffic port is not allocated an IP address but nevertheless 
functions independently of the M&C port since traffic packets are simply bridged 
over the port as required. 
 
Note that TXMission modems currently support only an Ethernet bridging function. 
Even when routing is used elsewhere in the network, the satellite link can always 
be implemented as a bridge. 
 
When Ethernet is used with DVB-S2/X, user traffic is encapsulated using the 
Generic Stream Encapsulation (GSE) protocol (ETSI TS 102 606-1), which 
provides a way of carrying packet-oriented traffic inside DVB-S2/X satellite 
frames.  
 
Care should be taken not to lose access to a modem by changing its IP address to 
one that is not compatible with the wider control network. 
 

• Subnet Mask 
 

The subnet mask of the modem is entered in dotted decimal notation (e.g. 
10.1.0.1). 
 

• Gateway 
 

The gateway of the modem provides access to the wider network beyond the 
immediate satellite network (such as the internet) and is entered in dotted decimal 
notation (e.g. 10.1.0.1). 
 

• Data Interface 
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The data interface is the physical interface used to route user traffic in and out of 
the modem. 
 
The following interfaces are selectable: 
 
 

o Ethernet 
o LVDS 
o RS485 

 
 
The following interfaces are physically available but currently reserved: 
 
 

o SDI/ASI 
o USB 
o UART 
o CAN 
o I2C 
o SPI 
o SpaceWire 

 
 

Even when a non-Ethernet interface is used then the modem’s Ethernet port 
remains accessible for monitor and control purposes. 
 

 

3.5.1.2 Modulator Menu Options 

The Modulator menu allows entry of the following: 
 
 

• Tx service 
 

The Tx service can be set to the following: 
 

o Off: this switches the transmit service off. 
 

o DVB-S2: this switches the transmit service to DVB-S2 operation (EN 302 
307-1). 

 
o DVB-S2X: this switches the transmit service to DVB-S2X operation (EN 

302 307-2). 
 

o CCSDS DVB-S2: this switches the transmit service to CCSDS over DVB-
S2 operation (CCSDS 131.3-B-1). 

 
o CCSDS DVB-S2X: this switches the transmit service to CCSDS over DVB-

S2X operation (proprietary extension to CCSDS 131.3-B-1). 
 

o CCSDS Viterbi: this switches the transmit service to CCSDS operation 
(CCSDS 131.0-B-1) using Viterbi only. 
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o CCSD Viterbi-RS: this switches the transmit service to CCSDS operation 
(CCSDS 131.0-B-1) using both Viterbi and Reed-Solomon encoding. 

 

• Tx modcod 
 
A modcod is the combination of a modulation and Forward Error Correction (FEC) 
rate. The following transmit modcods are supported: 
 

o DVB-S2 Normal frame: 
 
QPSK 1/4, 1/3, 2/5, 1/2, 3/5, 2/3, 3/4, 4/5, 5/6, 8/9, 9/10 
8PSK 3/5, 2/3, 3/4, 5/6, 8/9, 9/10 
16APSK 2/3, 3/4, 4/5, 5/6, 8/9, 9/10 
32APSK 3/4, 4/5, 5/6, 8/9, 9/10 
 

o DVB-S2 Short frame: 
 

QPSK 1/4, 1/3, 2/5, 1/2, 3/5, 2/3, 3/4, 4/5, 5/6, 8/9 
8PSK 3/5, 2/3, 3/4, 5/6, 8/9 
16APSK 2/3, 3/4, 4/5, 5/6, 8/9 
32APSK 3/4, 4/5, 5/6, 8/9 

 
o DVB-S2X Normal frame: 

 
QPSK 13/45, 9/20, 11/20 
8PSK 23/36, 25/36, 13/18 
8APSK-L 5/9, 26/45 
16APSK 26/45, 3/5, 28/45, 23/36, 25/36, 13/18, 7/9, 77/90 
16APSK-L 5/9, 8/15, 1/2, 3/5, 2/3 
32APSK 32/45, 11/15, 7/9 
32APSK-L 2/3 
64APSK 11/15, 7/9, 4/5, 5/6 
64APSK-L 32/45 
128APSK 3/4, 7/9 
256APSK 32/45, 3/4 
256APSK-L 29/45, 2/3, 31/45, 11/15 
 

o DVB-S2X Short frame: 
 
QPSK 11/45, 4/15, 14/45, 7/15, 8/15, 32/45 
8PSK 7/15, 8/15, 26/45, 32/45 
16APSK 7/15, 8/15, 26/45, 3/5, 32/45 
32APSK 2/3, 32/45 
 

o CCSDS Viterbi-RS: 
 
Viterbi: BPSK, QPSK & OQPSK 1/2, 2/3, 3/4, 5/6, 7/8 
Reed-Solomon: 

Symbols per codeword: 255 
Error correction values: 8 & 16 
Codes include (255, 233) & (255, 239) plus shortened codeblocks 
Interleaver depth: 1, 2, 3, 4, 5 & 8 
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• Tx frame size 
 
This is used only in DVB-S2/S2X modes of operation and can be set to: 
 

o Normal 
 

Normal operation uses a satellite frame size of 64,800 bits. This allows the 
error correction to work more efficiently and therefore has better Es/No 
performance than the equivalent modcod using the short frame size. 
 
A downside is that latency through the encoder/decoder is four times that 
of short frames. Latency halves as data rate doubles therefore for high 
data rate links, or latency insensitive traffic, the use of normal frames is 
recommended. 
 

o Short 
 

Short operation uses a satellite frame size of 16,200 bits. 
 

• Tx pilots 
 
Pilots are used only in DVB-S2/S2X modes of operation and can be set On or Off.  
 
Pilots are a signal that is added to the transmitted carrier to make it easier for the 
receiver to lock onto the carrier. Pilots are typically used when there is a poor 
signal at the receiver. The receiver can usually stay locked onto a carrier 
containing pilot tones lower down into the noise. 
 
The downside of using pilots is that they take up around 2.4% of the carrier 
bandwidth. When comparing the spectral efficiency versus Es/No of carriers using 
pilots they generally lie on the same straight line as carriers that are not using 
pilots, therefore the choice whether to use them will come down to practical 
considerations such as the satellite link budget calculation or the need to 
overcome interference on a link caused by the prevailing conditions.  
 

• Tx data rate 
 
Transmit data rate and symbol rate are interlinked. If the operator enters a non-
zero symbol rate then the data rate will be calculated automatically using the 
current settings (modcod, frame size, etc.). 
 
If a data rate is entered then the symbol rate will be automatically calculated. 
 
Minimum and maximum data rates are determined by the specific model of 
modem and vary with the modcod being used (since the choice of modcod 
changes the symbol rate). Typically, data rates of up to 1Gbps are supported 
subject to the choice of modcod. 
 
Data rates are entered in Mbps with up to six figures after the decimal point (e.g. 
500.123456 Mbps). 
 

• Tx symbol rate 
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As discussed above, symbol rate and data rate are interlinked and the symbol rate 
will be automatically set from the data rate unless it is entered by the operator. 
 
Minimum and maximum symbol rates are determined by the specific model of 
modem and the carrier roll-off factor being used. Typically, an occupied bandwidth 
of 125MHz is supported, which equates to a maximum of 119Msps when 5% roll-
off is used. 
 
Symbol rates are entered in Msps with up to six figures after the decimal point 
(e.g. 100.123456 Msps). 
 
 
 

• Tx frequency 
 
Minimum and maximum frequencies are determined by the specific model of 
modem. Typically, frequencies between 75MHz up to 6GHz are supported. 
 
Frequencies are entered in MHz with up to six figures after the decimal point (e.g. 
1220.123456 MHz). 
 
Note that in some older models of modems, there is a single LO synthesizer 
shared between transmit and receive and consequently the transmit and 
receive centre frequencies must be the same (carriers can still be 
transmitted and received on different frequencies but this then becomes a 
function of the off-board frequency conversion). 
 
Further up/down frequency conversion may optionally be performed externally to 
the modem (e.g to and from X-band) in which case the modem provides an 
intermediate frequency to the external equipment and must receive a carrier from 
the equipment at a suitable frequency. 
 
Care should be taken not to lose access to a modem by changing its frequency to 
one that does not match the control network. The use of pre-defined 
configurations is recommended in this regard, as it elimates the potential for 
mistakes when manually entering information. 
 

• Tx carrier roll-off 
 
The carrier roll-off can be set to the following values: 
 

o 5% 
o 10% 
o 15% 
o 20% 
o 25% 
o 35% 
o 40% 

 
Use of a lower roll-off will result in a lower occupied bandwidth for the carrier. 
However, the peak-to-average-power ratio (crest factor) of the carrier increases 
for lower values, meaning that a higher back-off is required for the transmit 
amplifier in order not to overdrive it and distort the carrier. 
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• Tx output power 
 
The modem outputs a very small signal, around a milliwatt or less. This needs to 
be fed into a power amplifier for onward transmission. (TXMission provides a 
variety of RF solutions covering offboard frequency conversion, power 
amplification, LNAs and bandpass filters – contact us for details.) 
 
Minimum and maximum power levels are determined by the specific model of 
modem but are typically in the range of -40dBm to -5dBm (or 0dBm). 
 
 
The power level is entered as a negative number in dBm with one figure after the 
decimal point (e.g. -15.7 dBm). 
 

• Tx carrier 
 
This control allows the transmit carrier to be switched Off or On. 
 

 

3.5.1.3 Demodulator Menu Options 

The Demodulator menu allows entry of the following: 
 
 

• Rx service 
 

The Rx service can be set to the following: 
 

o Off: this switches the receive service off. 
 

o DVB-S2: this switches the receive service to DVB-S2 operation (EN 302 
307-1). 

 
o DVB-S2X: this switches the receive service to DVB-S2X operation (EN 302 

307-2). 
 

o CCSDS DVB-S2: this switches the receive service to CCSDS over DVB-
S2 operation (CCSDS 131.3-B-1). 

 
o CCSDS DVB-S2X: this switches the receive service to CCSDS over DVB-

S2X operation (proprietary extension to CCSDS 131.3-B-1). 
 

o CCSDS Viterbi: this switches the receive service to CCSDS operation 
(CCSDS 131.0-B-1) using Viterbi only. 

 
o CCSD Viterbi-RS: this switches the receive service to CCSDS operation 

(CCSDS 131.0-B-1) using both Viterbi and Reed-Solomon encoding. 
 

• Rx modcod 
 
A modcod is the combination of a modulation and Forward Error Correction (FEC) 
rate. The following receive modcods are supported: 
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o DVB-S2 Normal frame: 

 
QPSK 1/4, 1/3, 2/5, 1/2, 3/5, 2/3, 3/4, 4/5, 5/6, 8/9, 9/10 
8PSK 3/5, 2/3, 3/4, 5/6, 8/9, 9/10 
16APSK 2/3, 3/4, 4/5, 5/6, 8/9, 9/10 
32APSK 3/4, 4/5, 5/6, 8/9, 9/10 
 

o DVB-S2 Short frame: 
 

QPSK 1/4, 1/3, 2/5, 1/2, 3/5, 2/3, 3/4, 4/5, 5/6, 8/9 
8PSK 3/5, 2/3, 3/4, 5/6, 8/9 
16APSK 2/3, 3/4, 4/5, 5/6, 8/9 
32APSK 3/4, 4/5, 5/6, 8/9 

 
o DVB-S2X Normal frame: 

 
QPSK 13/45, 9/20, 11/20 
8PSK 23/36, 25/36, 13/18 
8APSK-L 5/9, 26/45 
16APSK 26/45, 3/5, 28/45, 23/36, 25/36, 13/18, 7/9, 77/90 
16APSK-L 5/9, 8/15, 1/2, 3/5, 2/3 
32APSK 32/45, 11/15, 7/9 
32APSK-L 2/3 
64APSK 11/15, 7/9, 4/5, 5/6 
64APSK-L 32/45 
128APSK 3/4, 7/9 
256APSK 32/45, 3/4 
256APSK-L 29/45, 2/3, 31/45, 11/15 
 

o DVB-S2X Short frame: 
 
QPSK 11/45, 4/15, 14/45, 7/15, 8/15, 32/45 
8PSK 7/15, 8/15, 26/45, 32/45 
16APSK 7/15, 8/15, 26/45, 3/5, 32/45 
32APSK 2/3, 32/45 
 

o CCSDS Viterbi-RS: 
 
Viterbi: BPSK, QPSK & OQPSK 1/2, 2/3, 3/4, 5/6, 7/8 
Reed-Solomon: 

Symbols per codeword: 255 
Error correction values: 8 & 16 
Codes include (255, 233) & (255, 239) plus shortened codeblocks 
Interleaver depth: 1, 2, 3, 4, 5 & 8 
 

• Rx frame size 
 
This is used only in DVB-S2/S2X modes of operation and can be set to: 
 

o Normal 
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Normal operation uses a satellite frame size of 64,800 bits. This allows the 
error correction to work more efficiently and therefore has better Es/No 
performance than the equivalent modcod using the short frame size. 
 
A downside is that latency through the encoder/decoder is four times that 
of short frames. Latency halves as data rate doubles therefore for high 
data rate links, or latency insensitive traffic, the use of normal frames is 
recommended. 
 

o Short 
 

Short operation uses a satellite frame size of 16,200 bits. 
 

• Rx pilots 
 
Pilots are used only in DVB-S2/S2X modes of operation and can be set On or Off.  
 
Pilots are a signal that is added to the transmitted carrier to make it easier for the 
receiver to lock onto the carrier. Pilots are typically used when there is a poor 
signal at the receiver. The receiver can usually stay locked onto a carrier 
containing pilot tones lower down into the noise. 
 
The downside of using pilots is that they take up around 2.4% of the carrier 
bandwidth. When comparing the spectral efficiency versus Es/No of carriers using 
pilots they generally lie on the same straight line as carriers that are not using 
pilots, therefore the choice whether to use them will come down to practical 
considerations such as the satellite link budget calculation or the need to 
overcome interference on a link caused by the prevailing conditions.  
 

• Rx data rate 
 
Receive data rate and symbol rate are interlinked. If the operator enters a non-
zero symbol rate then the data rate will be calculated automatically using the 
current settings (modcod, frame size, etc.). 
 
If a data rate is entered then the symbol rate will be automatically calculated. 
 
Minimum and maximum data rates are determined by the specific model of 
modem and vary with the modcod being used (since the choice of modcod 
changes the symbol rate). Typically, data rates of up to 1Gbps are supported 
subject to the choice of modcod. 
 
Data rates are entered in Mbps with up to six figures after the decimal point (e.g. 
500.123456 Mbps). 
 

• Rx symbol rate 
 
As discussed above, symbol rate and data rate are interlinked and the symbol rate 
will be automatically set from the data rate unless it is entered by the operator. 
 
Minimum and maximum symbol rates are determined by the specific model of 
modem and the carrier roll-off factor being used. Typically, an occupied bandwidth 
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of 125MHz is supported, which equates to a maximum of 119Msps when 5% roll-
off is used. 
 
Symbol rates are entered in Msps with up to six figures after the decimal point 
(e.g. 100.123456 Msps). 
 

• Rx frequency 
 
Minimum and maximum frequencies are determined by the specific model of 
modem. Typically, frequencies between 75MHz up to 6GHz are supported. 
 
Frequencies are entered in MHz with up to six figures after the decimal point (e.g. 
1220.123456 MHz). 
 
Note that in some older models of modems, there is a single LO synthesizer 
shared between transmit and receive and consequently the transmit and 
receive centre frequencies must be the same (carriers can still be 
transmitted and received on different frequencies but this then becomes a 
function of the off-board frequency conversion). 
 
Further up/down frequency conversion may optionally be performed externally to 
the modem (e.g to and from X-band) in which case the modem provides an 
intermediate frequency to the external equipment and must receive a carrier from 
the equipment at a suitable frequency. 
 
Care should be taken not to lose access to a modem by changing its frequency to 
one that does not match the control network. The use of pre-defined 
configurations is recommended in this regard, as it elimates the potential for 
mistakes when manually entering information. 
 

• Rx carrier roll-off 
 
The carrier roll-off can be set to the following values: 
 

o 5% 
o 10% 
o 15% 
o 20% 
o 25% 
o 35% 
o 40% 

 
Use of a lower roll-off will result in a lower occupied bandwidth for the carrier. 
However, the peak-to-average-power ratio (crest factor) of the carrier increases 
for lower values, meaning that a higher back-off is required for the transmit 
amplifier in order not to overdrive it and distort the carrier. 
 

 

3.5.2 Networks Menu 

The Networks menu is described in Sections 3.3 and 3.4 (setting up and using networks). 
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3.5.3 Sites Menu 

The Sites menu is described in Sections 3.3 and 3.4 (setting up and using networks). 
 
 

3.5.4 Devices Menu 

The Devices menu is described in Sections 3.3 and 3.4 (setting up and using networks). 
 
 

3.5.5 Configurations Menu 

The Configurations menu (Figure 3-19) is used to store, load and delete modem 
configurations. 
 
Modem configurations are managed independently of other network resources, such as 
sites and devices and are held in a separate table within the application database. 
Modem configurations are therefore available to be used with all devices in the network. 
 
The easiest way of transferring modem configurations around the network is to FTP the 
MissionSpan database to each modem manually (contact us for details). (In future, this 
feature will be supported within MissionSpan.) 
 
 
 

 
 

Figure 3-19  Configurations Menu 
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To load a configuration, select it from the dropdown box and click on the Load button. The 
configuration can now be viewed and edited using the Modem Configuration (Home) 
menu. 
 

 

 
When a configuration is loaded, it is copied from the database to the 
current configuration. The title of each configuration screen will 
show the Modem ID from the current configuration and the original 
configuration name (in the case of Figure 3-19, these are CubeSat 
CyranoZeta and Orbital Configuration 1, respectively). 
 
When the modem is power cycled, it is the current configuration 
that is loaded. Changes to configurations can only be made through 
the current configuration. The operator will therefore typically load a 
configuration, edit it as the current configuration and then store the 
current configuration as a named configuration (either as the 
original configuration name or to a configuration with a new name). 
 
Changes made to the current configuration are stored immediately 
into the database as they are made. However, if another 
configuration were to be loaded without saving any changes to the 
current configuration beforehand, then the changes would be lost 
since the current configuration is overwritten at this point. 

 
 
Note that Factory configuration is a special configuration. By loading the factory 
configuration, the operator can create a new configuration starting from the factory default 
settings. 
 
To delete a configuration, select it from the dropdown box and click on the Delete button. 
Click OK on the resulting dialog to confirm the deletion. The factory configuration cannot 
be deleted. 
 
To save a new configuration, or overwrite an existing configuration, enter the 
configuration name in the Create section and click the Create button. 
 
 

3.5.6 Users Menu 

The Users menu (Figure 3-20) is used to add, delete and edit user details and can also 
be used to log out of the application. 
 
Details entered for users can be applied equally to access MissionSpan and/or network 
devices such as modems. 
 
The default MissionSpan user is admin (default password txmission). There are no limits 
on the number of users that can be added. 
 
Currently, MissionSpan does not support different levels of administration rights and all 
users have equal access and permissions. 
 
All passwords are stored in encrypted form in the database. 
 



MissionSpan NMS User Manual 
 

 3-34 
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Figure 3-20  Users Menu 
 
 
The name of the curren user is shown in the Logout section. Clicking on the Logout 
button logs the current user out and displays the login screen. 
 
The current user’s password can be changed in the Change Password section by 
entering the current password and new password and confirming the new password 
before clicking on the Change button. Passwords must be at least eight characters long. 
 
A new user can be added in the Add section by entering a user name, password and 
confirming the password before clicking on the Add button. There are no restrictions on 
the types or number of characters that can be part of a user’s name. Passwords must be 
at least eight characters long. 
 
A user can be deleted by selecting the user’s name from the dropdown box in the Delete 
section before clicking on the Delete button. 
 
There are no facilities for resetting forgotten passwords. It is recommended that 
MissionSpan’s database (smallsat_database.db stored in the root installation folder) is 
backed up regularly. By backing up the database, it may be possible to revert to logging 
in using an older username or password. Another technique is to reinstall MissionSpan on 
a different computer and then directly copy the User table of its database to the current 
MissionSpan database and then log in using the default admin username and password. 
 
 

3.5.7 Command Line Interface (CLI) Menu 

The CLI menu (Figure 3-21) provides a command line terminal emulator. 
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Figure 3-21  Command Line Interface (CLI) Menu 

 
 
This implements TXMission’s OOPS! command line protocol and provides an alternate 
way of managing network devices. OOPS! is documented in Interface Control Document 
Part 1: One and Only Protocol for Smallsats! (OOPS!), which can be viewed via 
MissionSpan’s Help menus and is also available on TXMission’s website. 
 
The CLI can also be used to define modem configurations in MissionSpan’s local 
database. When used in a local mode, each command that is issued updates the current 
configuration in the database. OOPS! supports the ability to store the current 
configuration to a named configuration in the database, or this can be done using the 
local Configurations menu once all the OOPS! commands have been issued. Essentially, 
the operation of MissionSpan’s Modem Configuration (Home) menu, the modem’s own 
web server and the command line interface are all completely interchangeable. For 
example, if a local command is issued, any configuration change will appear on the Home 
screen. 
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The operator can choose whether to send commands to update the local database (to 
create or edit modem configurations) or to any network device (which will action and 
update its own database when it receives the commands). To do this, select the network 
device to be controlled from the dropdown box and click the Submit button. 
 
The terminal emulator provides first-level command validation. It will display an error 
message in red if a command has an invalid format (Figure 3-22). A second level of 
validation occurs when commands are sent to the actual network devices, which check, 
for example, that parameters such as data rates are within the operating limits of the 
device. When a command has been successfully executed then the display shows a 
start-of-line prompt in green. 
 
It should be noted that the CLI interface supports several commands that are not yet 
supported directly on MissionSpan’s general menu system, such as downloading device 
log files. Future version of MissionSpan will support the ability to store and execute 
command scripts, allowing automated device control for both test and operational 
environments. 
 
For users wishing to implement their own network control system, TXMission provides 
sample code on request that can act as a template for the client-side application. This 
includes a terminal emulator, command parser (which checks for correct command format 
and reports errors) and a sockets module for encapsulating/decapsulating and 
sending/receiving messages. 
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Figure 3-22  Command Line Interface (CLI) Menu – showing error messages 

 
 

3.5.8 System Log 

The Log screen (Figure 3-23) provides access to MissionSpan’s log. Generally, this 
shows local activity including operator logins, logouts, screen and database accesses and 
any errors that occur. 
 
When MissionSpan is used to access network modems then these have their own logging 
systems and while their logs can be displayed in MissionSpan, they are stored only on 
the modems. 
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Figure 3-23  System Log 

 
 

3.5.9 Help Menu 

The Help menu is currently reserved for future use. Help is available through the 
application-level Help menu described in the next section. 
 
 

3.6 Application Menus 

MissionSpan’s main menus are shown in Figure 3-23 through 3-27. 
 
 

 
 

Figure 3-23  Application File Menu 
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Figure 3-24  Application Display Menu 
 
 

 
 

Figure 3-25  Application View Menu 
 
 
 

 
 

Figure 3-26  Application Help Menu 
 
 

 
Figure 3-27 Navigation Menu 

 
 
These provide the options described in the following sections. 
 

 

3.6.1 File Menu Exit Option 

Selection of the File menu Exit option causes the current instance of the MissionSpan 
application to close. This has no effect on the operation of any of the networks. 
 
Follow the instructions earlier in this manual to restart the application and log in. 
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3.6.2 Display Menu Network Option 

Selection of the Display menu Network option causes MissionSpan to switch out of Local 
mode and to show the user interface for the last network device that was previously 
selected, in the display area (Figure 3-28). 
 
In Network mode, the operator is connected directly to the devices in the network and can 
control and monitor them using their built-in user interfaces, which appear to the right of 
the navigation tree. Selection of Network mode is automatic when the operator selects a 
device from the navigation tree. Different menu colour schemes are used for Local and 
Network mode, namely, silver for local mode and amber for network mode. 
 
 

 
 

Figure 3-28  Network Mode showing access to remote devices 
 
 

3.6.3 Display Menu Local Option 

Selection of the Display menu Local option causes MissionSpan to switch out of Network 
mode and to show MissionSpan’s local menu system in the display area. 
 
Different menu colour schemes are used for Local and Network mode, namely, silver for 
local mode and amber for network mode. 
 

 

3.6.4 View Menu 

The View menu provides zoom (in, out and reset) functions for the right-hand side display 
area. These may be useful in adjusting the MissionSpan application for optimal viewing 
when using different monitors and screen resolutions. 
 

 

3.6.5 Help Menu Help Option 

Selection of the Help menu Help option causes MissionSpan to display this user manual. 
 

 

3.6.6 Help Menu About Option 

Selection of the Help menu About option causes MissionSpan to display version 
information for the application (Figure 3-29). 
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Figure 3-29  Application About Box 
 
 

3.6.7 Navigation Menu Refresh Option 

Selection of the Navigation menu Refresh option causes the navigation tree to be 
refreshed. 
 
If the operator changes any aspect of the network definition then the navigation tree will 
be refreshed automatically. However, in a multi-operator scenario, the network tree will 
not automatically update if another operator changes the network, assuming there is a 
centrally located database that is being shared by all operators. 
 

 

3.6.8 Navigation Menu Expand/Collapse Option 

Selection of the Navigation menu Expand/Collapse option causes all the nodes in the 
navigation tree to either expand (showing all devices for all sites) or collapse (showing 
just the sites that are part of the network). 
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4  Appendix: Modem Simulator 

 
 
Although MissionSpan is primarily designed to be used with TXMission satellite modems, 
it can be useful to use it with a TXMission modem simulator. For example, simulators can 
be used to check the operation of newly created modem configurations prior to their 
deployment in a live network. The use of modem simulators is also useful when becoming 
familiar with MissionSpan and training operators. The modem simulator is provided free of 
charge as a separate installation file to all MissionSpan users. 
 
The modem simulator can run on the same computer as MissionSpan and/or any number 
of other computers. The modem simulator comprises TXMission’s modem web server 
combined with logic that simulates modem operation, such as the output of status 
information. 
 
 

4.1 Installing the Modem Simulator 

The modem simulator is a web server that runs on Windows, Linux and other computers 
that support a node.js environment. Node.js is a framework for running JavaScript 
applications. The modem simulator installation zip file includes node.js for 64-bit Windows 
environments. Versions of node.js for other environments can be downloaded from 
https://nodejs.org/en/download/.  
 
 

 

 
The modem simulator, as shipped, is dependent on a specific 
version of node.js being installed. Please install the version of 
node.js included in the installation zip file. If you already have a later 
version of node.js installed then you will have to uninstall it and 
install the version provided by TXMission. Some node.js modules 
have been cross-compiled for an Intel processor environment – 
please contact us if you intend installing the modem simulator onto 
a computer that has a non-Intel processor. 

 
 
A Windows computer should meet the following specification as a minimum (when used 
with other operating systems, the computer should provide equivalent resources): 
 
 

5. Microsoft Windows 10 (recommended but not essential) 
6. Intel i5 processor (recommended but not essential) 
7. 8GB memory 
8. 100MB of free disk space 

 
 

 

 
The modem simulator is provided as a compressed 7-Zip file 
(Figure 4-1). 7-Zip is an archiving tool that can be downloaded 
freely from the internet. WinZip can also be used. Ensure that 7-Zip 
or a compatible archive tool is available before proceeding. 
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Figure 4-1  Modem Simulator Installation Zip File 
 

 
The installation process for the application is as follows: 
 

 
1. Navigate to the destination folder where the modem simulator is to be installed 

and open the archive TXMission_Modem_Simulator_vx_x_x.7z (you may need to 
right-click on the file and select ‘Open’ or ‘Open archive’). The archive tool will 
display the contents of the zip file (see Figure 4-2). 

 
 

 
 

Figure 4-2  Modem Simulator Installation Zip File Contents 
 

 
2. Select the Extract button in order to extract all files and choose the destination 

folder as shown in Figure 4-3. 
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Figure 4-3  Extracting the Installation Zip File Contents 
 
 

3. Following extraction, the contents of the destination folder should now look like 
Figure 4-4. 
 
 

 
 

Figure 4-4  Installation Folder Contents 
 

 
4. Before the modem simulator can be run, it is necessary to install the node.js 

runtime environment. Double click on the node-vx.x.x-x64.msi file to start the 
installation. 
 

5. Click Next on the node.js setup wizard Welcome screen. 
 

6. Review and accept the license agreement before clicking Next. 
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7. The installer will prompt for a installation location. When this has been selected 

click on Next. 
 

8. The wizard will let you select components to include or remove from the 
installation. Accept the defaults by clicking Next. 

 
9. Finally, click the Install button to run the installer and when it finishes, click Finish. 

 
 

4.2 Runing the Modem Simulator 

To run the modem simulator following installation, do the following. 
 
 

1. Start a Windows command prompt by entering command prompt into Windows 
Start Menu search box and then select the Command Prompt application, right 
click and select Run as administrator (Figure 4-5). 
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Figure 4-5  Starting a Command Prompt Window 
 
 

2. Change to the installation folder by entering cd install_folder where install_folder is 
the pathname of your modem simulator installation folder. 

 
3. Then enter node bin\www to start the modem simulator (Figure 4-6). Note that a 

firewall warning screen like that of Figure 3-2 will be displayed – allow the modem 
simulator to communicate over at least the local network. Various messages will 
then be displayed, as shown, in the console window (Figure 4-6) as it starts up. 
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 Figure 4-6  Starting the Modem Simulator in Node.js 
 
 

4. The web server element of the modem simulator is accessible via port 3000 on 
the localhost address. To check the web server is running correctly, access it 
using any web browser on the computer using the address 127.0.0.1:3000 
(Figure 4-7). 

 
 

 
 

Figure 4-7  Checking the Modem Simulator in a Web Browser 
 
 

5. If the modem simulator is running on the same computer as MissionSpan then it 
can be accessed by loading Constellation 1 inside MissionSpan and selecting any 
device (Figure 4-8) from the navigation tree (which are all set up to use the local 
host address). 
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Figure 4-8  Accessing local version of Modem Simulator from MissionSpan 
 
 

6. To access the modem simulator on a different computer from MissionSpan then 
change the device’s IP address within MissionSpan accordingly (as described 
earlier in this manual). An example is shown in Figure 4-9. Note that it may be 
necessary to provide access through any firewalls on both computers (the modem 
simulator web server runs on port 3000 and an OOPS! command handler listens 
for commands on port 5555). 
 
 

 
 

Figure 4-9  Setting MissionSpan to access Modem Simulator on another computer 
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5  Appendix: Troubleshooting Guide 

 
Most issues that occur when using MissionSpan to communicate with the modem 
simulator are due to firewall restrictions. MissionSpan itself does not require any firewall 
permissions. However, the modem simulator does require permissions. 
 
If problems are being experienced in connecting MissionSpan to the modem simulator, 
open up the firewall application on the computer that the modem simulator is installed on 
and select the option that allows a program through the firewall (often titled ‘Allow a 
program of feature through Windows Firewall’). Search for ‘Node.js: Server-side 
JavaScript’ (Figure 5-1). Enable the application and select OK. 
 
 

 
Figure 5-1  Allowing the Modem Simulator to communicate through a firewall 

 
 

If this does not fix the issue then other things to try are as follows: 
 
 

• Check the IP address and subnet mask being used for the modem or modem 
simulator. Make sure that you can ping the address from the computer on which 
MissionSpan is installed. 
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• If using the modem simulator, try installing it initially on the same computer as 
MissionSpan and try to connect to it from MissionSpan using the local host 
address 127.0.0.1:3000. 

• Look for error messages in the MissionSpan system log to see if these indicate 
abnormal behaviour, such as permissions problems accessing files or files being 
missing. If this happens, then reinstall MissionSpan as an administrator. 

• Although MissionSpan supports multiple instances running at the same time, old 
instances that have not been closed properly can potentially interefere with file 
access. In this case start Windows Task Manager and close all instances of 
MissionSpan and start again. Similarly, for the modem web server. 

• If a connection issue arises when using MissionSpan’s command line interface, 
refresh the page (reselect the CLI tab from the fly-out navigation menu) as even 
when the problem has been fixed (e.g. by changing firewall permissions) the 
connection still needs to be restarted. 


